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Today's talk

Bottom up description of
Science Plan

Individual Science Topics
Approaches / Regions
Questions
Mission / Objective
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Mission / Objectives /
Project History

Key Questions /
Research Strategies

Approaches /
Regional Research Groups

Individual Research
Topics




Bottom up drafting process

» 20 Jan.2018: PostMAHASRI Planning Workshop

» Nagoya University, Japan / More than 40 researchers

» 15-16 Mar. 2018: Intern’'l PostMAHASRI Planning WS

» TMU, Japan / Total 63 international researchers

Scientific Approaches (6)
» 20 May 2018: |JpGU 2018, Post MAHASRI session

Obijectives & Missions Research Strategies
» Organizing Drafting WGs (0-6)
» 6-7 Oct. 2018: Ist Drafting Core Meeting
Key Questions (5)
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Scientific Approaches

» To Understand Asian Monsoon Land Precipitation;

I. Observation and Estimation of Variation and Extremes in Asian
Land Precipitation and Important Variables

2. Process Studies of Asian Land Precipitation Focusing on
Diverse Land-Atmosphere Interactions

3. Understanding and Prediction of Variability of Asian Monsoon
from Subseasonal to Interdecadal Time Scales

4. High Resolution Land Surface Hydrological Modeling and
Monitoring Incorporating Impacts of Human Water
Withdrawal, Agriculture,Vegetation and Cryosphere

5. Coordinated Observation and Modeling Initiatives

6. Detection and Projection of the Climate Change Impact on
Regional Precipitation in the Asian Monsoon Region
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Tentative Groups/Sections for
drafting post-MAHASRI Science Plan

* Current and near-future in-situ observations and field
campaigns

* Data rescue of old/historical observations

 Various spatio-temporal variability of Asian monsoon
and its relation with land-atmosphere interaction

* Land surface hydrology and water resources, including
agriculture and glaciers

e Research infrastructure such as Satellite, Climate change
information such as CORDEX, Data and data-center, etc.
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Objectives of the Post MAHASRI

» General Objective

» Understanding of Asian Land Precipitation over
Diverse Hydroclimatological Conditions: For Better
Prediction, Disaster Reduction and Sustainable
Development
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Research Strategies

» Impacts of Diversed Land Surface: Topography, Cryosphere,Vegetation,
Land Use and Coast Lines on Diurnally Varying Precipitation Process in
Multiple Time Scales from Sub-seasonal to Climate Change

» Hydrological Modeling which Incorporates Human Water Withdrawal
and Impacts of Agricultural Activity and Biosphere in Monsoon Asia

» Targeted and Integrated Observation Projects Coordinated with New
Generation High Resolution Dataset, Modeling, Radar Network, and
Satellites / Coordinated Regional Process Studies

» Playing a Key Role in S2S (Sub-seasonal to Seasonal) Prediction Project
» Data Rescue for 200-Year Climate Change Detection: with ACRE

» Regional Climate Projection and Dynamic and Statistical Downscaling
Collaborating with Modeling Community including CORDEX
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Chairs of each WG / Section in Chap. 3

» Sections in Chap. 3: Scientific Approaches

I. Observation and Estimation of Variation and Extremes EIREELCHINE!
in Asian Land Precipitation and Important Variables

2. Process Studies of Asian Land Precipitation Focusing on @REMEIEHEN]
Diverse Land-Atmosphere Interactions

3. Understanding and Prediction of Variability of Asian
Monsoon from Subseasonal to Interdecadal Time Scales Dr Takaya

4. High Resolution Land Surface Hydrological Modeling
and Monitoring Incorporating Impacts of Human Water
Withdrawal, Agriculture,Vegetation and Cryosphere

' TOKOI

5. Coordinated Observation and Modeling Initiatives
6. Detection and Projection of the Climate Change Impact
r Sato

on Regional Precipitation in the Asian Monsoon Region ——
Dr Kiguchi
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To be
solved in

Overarching Key Questions (0

» What is convincing and useful Climate Projection!?

» What coordinated Observation Initiative is needed?
» To what extent can we use up 200yr Rescued Data?
» How can we describe Extreme Weather?

» What is Mountain Precipitation and hydrological cycles!?



To be
solved in

Overarching Key Questions (0

» What is the convincing climate projection representations of
Asian monsoon precipitation that can support policymakers to
plan useful adaptation strategy for the changing climate!?

» What is the possible coordinated observation initiative that
advances our understanding of the Asian monsoon
precipitation?

» To what extent can we use up rescued hydrometeorological
data to reconstruct recent 200-year climate change!?

» How can we find new scientific methods to describe, and to
share information with Asian people, of the extreme weather
embedded in multiple time scales in Asian monsoon
hydroclimate!?

» What is the role of mountain precipitation and subsequent
land water process in the local and global hydrological cycles
and water resources?



Chapters of Science Plan

» Chapter |:Background and Obijectives

» Mission,Asian monsoon, History and Obijectives
» Chapter 2: Key Questions

» Strategies and Key Questions
» Chapter 3: Science Approaches

» Individual Descriptions of Six Approaches

» Chapter 4: Regional Studies
» Individual Descriptions of 10(?) Regional Studies

» Chapters 5-10

» Applications, Data Sharing, Collaborations, Capacity Building
and Technology Transfer, Funding, SSG/Conferences



Time Table for Science Plan

» GHP/Andex Workshop (Oct. 2018)

» 2nd Drafting Core Meeting (13 Nov. 2018)
» Dead line of Manuscripts: 10 Dec.2018

» Adjustments

» Science PlanVer. 1.0 (Dec.2018)

Project Name

» English Proof Reading,Ver. |.| (Early Jan.2019)
» Submit to GEWEX/SSG

GEWEX SSG Meeting (25 Sei.-l Mar.2019)

v

Approval as new RHP



Our Mission and Key Questions



Huge Mission and Asian Monsoon

» Why Asian land precipitation?
» Supporting Life of Huge Population (>4 Billion?) in Asia
» Expected Impacts of Climate Change

Extremes and Disasters / Crisis in Water Resources / Food Basket /
Human Health and Deseases / Sea Level Rise / Agricultural
Production / ...

» Do we understand what is Asian monsoon!?
» Is it a huge land-sea breeze, or migrating ITCZ!?

» We can not even reproduce observed precipitation and
complicated seasonal march of Asian monsoon using climate
models

» We should respond to demands of people and policimakers



» What is convincing and useful Climate Projection!?

» What coordinated observation initiative is needed?
» To what extent can we use up 200yr rescued data?
» How can we describe extreme weather?

» What is mountain precipitation and hydrological cycles?

CLIMATE CHANGE

Climate Projection

Data Rescue Extreme
past Observation Initiative f e
Attribution Mountain Addaptation



To be
solved in

Overarching Key Questions (0

» What is convincing and useful Climate Projection!?
» What coordinated observation initiative is needed?
» To what extent can we use up 200yr rescued data?
» How can we describe extreme weather?

» What is mountain precipitation and hydrological cycles?

4 N\

Research topics to solve these questions

\ /

4 2\

Synargy Effects are Already Emerging




To be
solved in

Overarching Key Questions (0

» What is convincing and useful Climate
Projection!? S

» What coordinated observation initiative is needed!?
» To what extent can we use up 200yr rescued data?
» How can we describe extreme weather?

» What is mountain precipitation and hydrological cycles?



[ Question | ]
Annual Precipitation in Climate Models

» Sperber et al. (201 3)

(2) GPCP (1979-2007) 0.93 (€) MIROC-ESM 062




Question | ]

Seasonal march in climate models

Annual Cycles (1999-2009) Monsoon Dynamics (1999-2009)
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Question |

ITCZ in Early version of AMIP

» We do not know why later CMIPs can represent the
northward migration of ITCZ in Asian monsoon region.

606 S0f 100 120t 140f 160F 180 G0 BOE 1006 1206 140E 1K€ 180
-:l:-
S Gadgil (2017) / Sajani (1999)




Subseasonal-to-Seasonal

ysas I AHASRI

Prediction Project

S2S-Post MAHASRI collaboration in future
hydrometeorological prediction research

) Yuhei Takayal, Toru Terao?, Jun Matsumoto?

*1 Meteorological Research Institute
*2 Kagawa University
*3 Tokyo Metropolitan University

SETIYE

National Institute of
Meteorological Scienc:

WMO S2S regional workshop for Asian countries, Gyeongju, 25-26 June 2018



Predictive understanding of Asian monsoon

Observation

Prediction
Atmosphere - Mocliel!lng
- Land - Analysis
- Ocean

Subseasonal-to-Seasonal

I AHASR|

Understanding
- Process

- Mechanism

- Predictability

29



Question I

Soil moisture impact on precipitation

4

28N 1

26N 1

24N 4

22N 4

20N 1

28N

Impacts of Land Surface on - TR
Diurnally Varying Precipitation in -+
Bangladesh Monsoon and Pre- |}
monsoon Seasons

23N 1
22N

.
21N

g 9 3 m-3)  one 7N "
Suglmoto and Takahashl (20'7) (m m ) 20N T E BBE BOE 90F O]€ O2E O3E 94 20N T B8E BOE 90F 91E O9F 93F 94F
(= \ Y,
0.05 0.15 0.25 0.35
2 Ramfall Intensity (Wet — Dry run)
2
) ,= IMPre-monsoon, B Monsoon
= Wetter
cc ! Stronger
oM™ g
s B :
8 1 Drier
= c
5 -2 Stronger
O
86F BBE 90E 92F 94E % 06-09LT 09-12LT 12-15LT 15-18LT 18-21LT 21-00LT 00-03LT 03-06LT

700 300 500 700 900 (m) Local Time



Question I

Convincing Climate Projection?

» Definition of convincing 'good’ climate projection criteria
» Understanding of Real Precipitation System

Collecting information of spatial structures of precipitation systems
(ex. MCS) utilizing remote sensing data such as radar and satellites
underpinned by in-situ obesrvations during upcoming |0 year period.

Explaining the variability of precipitation in the real atmosphere by the
variability of frequency and strength of precipitation systems.

» Assessment of Climate Models

Checking whether the models represent the frequency and strength
of precipitation systems as well as the variability and trends of
precipitation amount.

Cheking the model performance in modelled diurnally varying meso-
scale systems embedded in larger scale variation.



To be
solved in

Overarching Key Questions (0

» What is convincing and useful Climate Projection!?

» What coordinated observation initiative
is needed? = Question?2

» To what extent can we use up 200yr rescued data?
» How can we describe extreme weather?

» What is mountain precipitation and hydrological cycles?



[ Question 2 ]

AMY (Asian Monsoon _wensoo,
Years 2007-2012) s

&

.....

Overarching Goal:

“To improve Asian Monsoon
prediction for societal
benefits through improving
understanding of the
variability and predictability
of the Asian-Australian
monsoon system”

A, A
¥2007-2°

http://lwww.wcrp-amy.org/



‘ [ Question 2 ]
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BRAIN: Borderless Radar Information Networking

[

Queston2 | over South and Southeast Asia

Borderless Data Sharing
Real Time weather radar blending

~
- , P 2 10-year Target (-2028)

R
=
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Lo .-

First step AMY-II (2020)

bocha /W e ARUVD Tangs Tramoin Conte
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Radar data sharing for focused period
from May to July 2020
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AMY-II (2020) and Post MAHASRI

» Focus:

» Construction of the BRAIN (Borderless
Radar Information Network) within 10-
year project period

» AMY-II (2020)

» Sharing radar data among many Asian
meteorological agencies during core
observation period (May-July / 60days

Feacibility test of
radar network

» Coordinated observations

Pilot areas

Intensive R-S, PBL tower, Soil Moisture,
Wind profiler, GPS-PWV network, ...

» Utilized for model validation



Question 2

AMY-II(2020) Planning Meeting

» Honolulu, 6 June 2018

» 10 International Researchers (esp. Taiwan, China)

» Agenda

» Background

» Scientific Topics
Better understanding the processes of future Asian monsoon
Improvement of S2S prediction

» Obijectives

Aerosol-Monsoon/Tibetan Plateau and surrounding regions Land-
Atmosphere interactions/Indian Ocean-Western Pacific Air-Sea /
Future monsoon Asian climate



Question 2

AMY-II(2020) South Asian Project

» Focusing on Four Components in the Indian Subcontinent
» Northeast, Northwest, Central India,Western Ghats
» Different roles during seasonal transition and I1SV?
Transition from pre-monsoon to monsoon and in A/B cycle

O Different process in Northwest and Northeast and relathionship

O Role in monsoon onset of Northeast severe local storms in premonsoon

O Role of central India for onset r’jJ ; ~.
International Collaboration 0 YA Q;zﬁ?
O Northeast-> Japan group \<§3 \\/ e ;\jz\g
0 Northwest->? ‘LA(\ \ﬁég/ y
5 Central India-> ITM AN | LS
0 Western Ghats-> [ITM ) , k}
Modelling / RADAR \}0‘ @
- - I —



Question 2

Active /Break cycle

» Different frequency range
» Fujinami et al. (201 [)
» Northeast/OLR, North/U: QBW

» 30-60day variability in other area

» Correlation in A/B cycle
» Murata et al. (2017)

» Correlation with NE Rain
Negative in Central India and Western Ghats «

70€E BOE 90€ 100€ 110€

Positive? in Northwestern India 'A

20N

» Interactive framework
» LS-BL-Convection-UTLS

70E  80E 90E 100f 110E 120€ 130E 140



Approach 3

S2S Predictability and Land Surface

» Role of Land Surface for Predictability at different Time

Scales
alMmoSE ;
>\ {(WEa o-g
—
ra) 3
B Distance Im!
L Impact Assessment of Soil Moisture
8 land observation network on drought prediction
—
a- ocean
S / days 30 days .
Mariotti et al (2018) days Time



Question 2

Observation Supports Understandings

Mean wind profile perpendicular to the coastline

Composite for 8 days with Composite for
clear offshore migration other 19 days
00 gy v 800 ————r—+—{ 7
= oo
00 ' "0 +
5 820 ¢ o
&, 5 - | 00 | 90 | 1 Mirai
ok Bengkulu
o ONE =4 o8 ey s gy Yy
Oﬂw‘smfe Uy [m s571)
ol | Low-level offshore-ward vertical shear|which is important for
ak regeneration of convective cells offshore,

was observed only in days with clear offshore migration,
- only over coastal waters.

o

{
\Q May 20 2018 by Sakory Yokor (JAMSTEC)




To be
solved in

10 yrs

Overarching Key Questions

» What is convincing and useful Climate Projection!?

» What coordinated observation initiative is needed?

» To what extent can we use up 200yr
reSCUEd data? Question 3 Question 4

» How can we describe extreme weather?

» What is mountain precipitation and hydrological cycles?



Question 3

Question 4

Grid-rain / Long-term |

(]

xtreme Trend

VnGP: Gridded rainfall
data over Vietnam
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Locations of rainfall stations
over Vietnam
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Question 3

Impact of historical data rescue

» Kubota et al. (2016)

» PJ (P-] pattern) index from 1897 to 2013 was developed by
use of historical station-based pressure data in Philippine,

Taiwan and Japan, and compared with reanalyses (JRASS,
ERA40,20CRv2 and NCEP/NCAR.

» PJ-ENSO correlation was found to change in interdecadal time
scale.




[ Question 4 J
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To be
solved in

Overarching Key Questions (0

» What is convincing and useful Climate Projection!?
» What coordinated observation initiative is needed?
» To what extent can we use up 200yr rescued data?

» How can we describe extreme weather?

» What is mountain precipitation and
hydrological cycles? Question 5



Question 5

©Sparse in-situ observation (Precipitation c

P

Qs
A

Gauge Satellite

Reanalysis
(e.g., TRMM/PR; (e.g., ERA-Interim) Merged
GPM/DPR)

Thermal Resistance
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Uncertainty of
climate data
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Rainfall estimation

» IMD4 Gridded Rainfall (0.25deg x 0.25deg), 1901 -

» Based on raingauge observations
85" 90"

95°

1901-2013 ave




Monsoon TRMM NSR Climatology

88 89 90 91’ 92’ 93 94 95 96 97 98"

p 50 0 500 1000 15002000 25003000 3500 4000 4500 5000



New Project was Approved by JSPS

[ Mechanism of Rainfall Variability dur to Complex Topographhy and Large Scale Moist J

Atmospheric Flow over the Himalayan Range 5
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RHP Criteria

» Central Science and Application Questions

» Contribution to
» GEWEX Imperatives
» important WCRP Grand Challenges
» GEWEX Science Questions

» Coorination Mechanism (WGs/chairs)
» End Date and Exit Plan (In Chapter 2)

» Resources and personnel

» Mechanism for access to hydrometeorlogical data sets



GEWEX Science Imperatives

» Data Sets: Foster development of climate data records of atmosphere, water, land, and
energy--related quantities, including metadata and uncertainty estimates.

» Analysis: Describe and analyze observed variations, trends, and extremes (such as heat
waves, floods, and droughts) in water and energy--related quantities.

» Processes: Develop diagnostic approaches to improve process-level understanding of
energy and water cycles in support of improved land and atmosphere models.

» Modeling: Improve global and regional simulations and predictions of precipitation,
clouds, and land hydrology, and thus the entire climate system, through accelerated
development of models of the land and atmosphere.

» Applications:Attribute causes of variability, trends, and extremes, and determine the
predictability of energy and water cycles on global and regional bases in collaboration
with the wider WCRP community.

» Transfer: Develop diagnostic tools and methods, new observations, models, data
management, and other research products for multiple uses and transition to

operational applications in partnership with climate and hydrometeorological service
providers.

» Capacity Building: Promote and foster capacity building through the training of scientists
and outreach to the user community.



WCRP Grand Challenges

» Melting Ice and Global Consequences

» Clouds, Circulation and Climate Sensitivity

» Carbon Feedbacks in the Climate System

» Weather and Climate Extremes

» Water for the Food Baskets of the World

» Regional Sea-Level Change and Coastal Impacts

» Near-term Climate Prediction



Next 5 to 10 years

GEWEX Science Questions (2013)

» Observations and Predictions of Precipitation:

» How can we better understand and predict precipitation variability
and changes!?

» Global Water Resource Systems:

» How do changes in land surface and hydrology influence past and
future changes in water availability and security?

» Changes in Extremes:

» How does a warming world affect climate extremes, esp. droughts,
floods, and heat waves, and how do land area processes, in particular,
contribute!?

» Water and Energy Cycles and Processes:

» How can understanding of the effects and uncertainties of water and
energy exchanges in the current and changing climate be improved
and conveyed!?



HOMNEHTINET !

Arigato- Gozaimasul!

Thank you very much!






Climate Change Research

» Data rescue toward 200 yrs under ACRE
» Trends in extremes and future prediction

» Mountain precipitation
» High vulunerabilities
» Already climate change impact appears



Mountain Rainfall (NE India)

» TRMM / IMD4 / d4pdf



Introduction to
Post MAHASRI Science Plan



Objectives of the Post MAHASRI

» General Objective

» Understanding of Asian Land Precipitation over
Diverse Hydroclimatological Conditions: For Better
Prediction, Disaster Reduction and Sustainable
Development.



Introduction to Post MAHASRI

» Why Asian land precipitation!?

» Huge population / climate change / disasters / human life / food
basket depend on Asian land precipitation

» What is major unknowns to be solved?

I Insufficient representation of climate models
Impact of human water withdrawal
Land surface-planetary boundary layer impact on convection
Precipitation prediction in S2S to interdecadal scales
Highland precipitation and hydrological processes
Evaluation and prediction of extremes

A o R

Change of precipitation during recent 200 years



1. Groundwater
recharge

2. Groundwater
abstraction

3. Aqueduct water
transfer

4. Local reservoirs

5. Seawater
desalination

6. Return flow and

delivery loss
Surface water

00 01 10 100 1000 10000

Water sources by region (Hanasaki et al., 2017)

(Hanasaki et al. 2017, HESSD)

There is still 21% ‘Unspecified
sources’ in global water use.

Major part of unspecified is
in Asia, probably from
irrigation.

Validation and
improvement by using
various sources of
information in Asia

(e.g., satellite data, local
data acecimilation?)



Scientific Approaches

» To Understand Asian Monsoon Land Precipitation,

I. Observation and Estimation of Variation and Extremes in Asian
Land Precipitation and Important Variables

2. Process Studies of Asian Land Precipitation Focusing on
Diverse Land-Atmosphere Interactions

3. Understanding and Prediction of Variability of Asian Monsoon
from Subseasonal to Interdecadal Time Scales

4. High Resolution Land Surface Hydrological Modeling and
Monitoring Incorporating Impacts of Human Water
Withdrawal, Agriculture,Vegetation and Cryosphere

5. Coordinated Observation and Modeling Initiatives

6. Detection and Projection of the Climate Change Impact on
Regional Precipitation in the Asian Monsoon Region



Approach |

Coast Line and Water Budget
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APProach 2

SOll mOj Impacts of Scienti_ﬁc Understanding_ )I’CCipitatiOn

» Impacts of Land Surface on - ot |
Diurnally Varying Precipitation in ..}~ {
Bangladesh Monsoon and Pre- | - N
monsoon Seasons . \ -

Sugimoto and Takahashi (2017) GIUDIRSLONEEE Qi S———
8 (2017)
0.05 0.15 0.25 0.35

Rainfall Intensity (Wet — Dry run)

M Pre-monsoon, M Monsoon

2 ’ -

v Wetter
Stronger

28N 1

26N 1

1.
o . r ' ' [ I Drier

Stronger
06-09LTO09-12LT 12-15LT 15-18LT 18-21LT 21-00LT O0-03LT 03-06LT
Local Time

(mm 3h-T)

22N 4

20N 1

APrecipitation intensity

86F BBE 90E 92F 94E
700 300 500 700 900 (m)



[ Approach 3 J

S2S Predictability and Land Surface

» Role of Land Surface for Predictability at different Time
Scales

atmosphere |
(weather)




Approach 4

Very high resolution modeling ~ Altimeter, Microwave

of surface water dynamics SWOT, SMAP, GCOM etc.
CaMa-Flood model (Yamazaki et alsﬁ@/ll 11)
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Overarching Science Questions

» What is the convincing climate model representations of Asian
monsoon precipitation that can support policymakers to plan
useful adaptation strategy for the changing climate!?

» What is the possible coordinated observation initiative that
advances our understanding of the Asian monsoon
precipitation?

» To what extent can we use up rescued hydrometeorological
data to reconstruct recent 200-year climate change!?

» How can we find new scientific methods to describe, and to
share information with Asian people, of the extreme weather
embedded in multiple time scales in Asian monsoon
hydroclimate!?

» What is the role of mountain precipitation and subsequent
land water process in the local and global hydrological cycles
and water resources?



Question 3

Impact of historical data rescue

» Kubota et al. (2016)

» PJ (P-] pattern) index from 1897 to 2013 was developed by
use of historical station-based pressure data in Philippine,

Taiwan and Japan, and compared with reanalyses (JRASS,
ERA40,20CRv2 and NCEP/NCAR.

» PJ-ENSO correlation was found to change in interdecadal time
scale.




Question 4

Extremes

» Unprecedently severe hydrometeorological disasters took
place in West-Japan, Kerala, Laos
» Daily rainfall is not enough to describe the extreme
» People's perception on extreme may have to be updated

» We can develop new method to describe, and to share
information with people, the concept of Extreme in multiple
time scales



Question 5

Mountain precipitation

» Many questions:
» How glacier increases/decreases!?
» What is distribution and variation of montain precipitation?
» Impacts of climate change appears earlier!?
» Glacier lakes?
» Scientific interest
» Topographic impact on convective systems

» Impact of Tibetan Plateau on global circulation

» Expected outcomes
» Improved precipitation griddata in Asiatic mountain area
» Reliable estimation of net reduction of glacier



AMY-II (2020) in Post MAHASRI Project

» RADAR data exchange for 60-day (May-July) period

» A sweet 'experience’ of borderless radar data exchange

» Field Campaign covering the same period
» Soil moisture observation (Remote sensing + ground truth)
» Intensified R-S observations

» Special instruments
wind profiler, micro rain radar, disdrometers

» GPS-Precipitable Water measurement network
» Surface Flux observation network

» Modelling and remote sensing
» Impact study / Ex. Soil moisture impact on S2S predictability

» Possible outcomes by 2023? -> Later half of PMP



AMY-II(2020) South Asian Project

» Focusing on Four Components in the Indian Subcontinent
» Northeast, Northwest, Central India,Western Ghats
» Different roles during seasonal transition and I1SV?
Transition from pre-monsoon to monsoon and in A/B cycle

O Different process in Northwest and Northeast and relathionship

O Role in monsoon onset of Northeast severe local storms in premonsoon

O Role of central India for onset r’jJ ; ~.
International Collaboration % VA Q;zﬁ?
O Northeast-> Japan group \<§3 \\/ e ;\jz\g
0 Northwest-> CURA| <LA(\ \hla‘kﬁ/ |
0 Central India, Western Ghats-> [ITM : \\\%" 1)/6
Modelling? / RADAR? \ ) | »
<A | Q
o 5 oS-



Active /Break cycle

» Different frequency range
» Fujinami et al. (201 [)
» Northeast/OLR, North/U: QBW

» 30-60day variability in other area

» Correlation in A/B cycle
» Murata et al. (2017)

70€E BOE 90€ 100€ 110€

» Correlation with NE Rain  iewwoome o
Negative in Central India and Western Ghats e,
Positive? in Northwestern India

» Interactive framework

» LS-BL-Convection-UTLS

i
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Post MAHASRI Planning Activities

» 17-19 Oct. 2017: GHP/TPE-WS (Kathmandu)
» 2 Nov.2017: Meeting in Sapporo

» Discussion of the collaboration with TPE for meso-scale modeling

» 20 Jan.2018: PostMAHASRI Planning Workshop
» Nagoya University, Japan
» More than 40 researchers

» 15-16 Mar. 2018: International PostMAHASRI Planning
Workshop

» TMU (Tokyo Metropolitan University), Japan

» |2 Asian researchers from 8 countries, Thailand,Vietnam, Philippine,
Indonesia, China, Nepal, India, Bangladesh

» Total 63 international researchers



Time Table for Science Plan

» The 8th GEWEX Science Conference (6-11 May 2018
@Canmore Canada)

» JpGU 2018, Post MAHASRI session (20 May 2018
@Makuhari Chiba)

Drafting / Work Groups 0-6
» Post MAHASRI Science Plan Core Workshop (Oct. 2018)
» GHP/Andex Workshop (Oct. 2018)
» Science Plan Ver. 1.0 (Dec. 2018)

Propose new RHP
» GEWEX SSG Meeting (25 Sep.-1 Mar.2019)

Approval as new RHP









Introduction to Post MAHASRI

» Why Asian land precipitation?

» Huge population / climate change / disasters / human life / food
basket are depend on Asian land precipitation

» Huge unknown --- Science is needed
Insufficient representation of monsoon prec. in climate models
Impact of human water withdrawal
Land surface impact on precipitation
Precipitation prediction in S2S to interdecadal scales

Highland precipitation
» Inconsistencies in the Understanding of Asian monsoon

» Huge land-sea breeze system or migrated ITCZ!?

Key process: Land surface process / convection

» Multiple time scales and diverse land impact on the atmosphere
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» We cannot even reproduce current Asian climate and
precipitation using climage models.

» For the policymakers including people, convincing result
of climate models are needed.

» We cannot go further without advancement of scientific
understanding of hydrometeorological processes.

» What can we do during upcoming |0 years!?
» Concrete individual research plan for scientific approaches
= 6 Approaches

» Croscutting questions that lead entire research project

= 5 Questions



History of Asian monsoon RHPs

» Pre-GAME

» WCRP / GEWEX / GHP / RHP Framework
» GAME / Focus and outcome

» MAHASRI / Focus:

» Outcome
Rainfall data (gauge based gridded datasets, GPM validation, historical)
High-resolution hydrological modeling
Process studies
Autumn/winter monsoon, monsoon onset/withdrawal
AMY and Collaboration and capacity building in Asian countries

» It is the time to launch post MAHASRI!



RHP’s in Monsoon Asia

» Monsoon Asia Hydroclimatological Research have
continued since 1995 under GAME and MAHASRI

GEWEX REGIONAL HYDROCLIMATE PROJECTS
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GAME /MAHASRI

» RHP of Asian Monsoon hydroclimate research
» GAME (1996-2005): GEWEX Asia Monsoon Experiments

Atmoshere-land surface interactions

Four regional components => Cross cutting (2002-2004) AME

0 GAME-Siberia, GAME/HUBEX, GAME-Tibet, GAME-Tropics

» MAHASRI (2006-2016): Monsoon Asian Hydro- Atmosphere
Scientific Research and Prediction Initiative

Hydro-meteorological prediction system, up to a seasonq ' D ASRI

Based on collaboration of several regional projects

0 Maritime Continent, Thailand, Mongolia,Vietnam, Philippines, India,
Bangladesh, ...



Overview of MAHASRI

Monsoon Asian Hydro-Atmosphere AH AS |
Scientific Research and Prediction |
Initiative(2006-2015)

http://mahasri.cr.chibau.ac.jp/

"To establish hydro-meteorological prediction
system, particularly up to seasonal time-scale,
through better scientific understanding of Asian
monsoon variability".

Jun Matsumoto

Department of Geography, Tokyo Metropolitan University, JAMSTEC/ DCOP
International Science Conference on MAHASRI , March 2, 2016
at Tokyo Metropolitan University, Japan

™



Objectives:

 Determining the predictability and key components
of Asian monsoon variability with a time scale up
to a season for the development of a hydro-
meteorological prediction system.

» Developing a real-time monitoring capability for
hydro-meteorological observations.

* Developing an integrated hydro-meteorological
database including data rescue.

 Examining and improving the hydro-meteorological
models in some specific river basins.



Outcomes / Impacts of MAHASRI

I, Since the GAME period, Asian operational agencies and
research communities strongly stimulate research activities
in monsoon Asia.

» Local agencies and research inst. development in Asian countries
» Education / capacity building / PhD / Co-authored papers

2. A real-time monitoring and flood prediction system have
been developed in the Chao Phraya River Basin in Thailand.

3. Dynamics of autumn/winter extreme rainfalls in Indochina
have been extensively investigated.

4. Rainfall data collection and satellite validation was
developed including data rescue.

5.  Collaboration with AMY community.
» Integrated Database (DIAS) in the Univ. Tokyo
» AMY Re-analysis by MRI (Meteorological Research Institute)



Impacts of MAHASRI Project

Diverse monsoon season

Monsoon onset / withdrawal of Philippine | . . |||I| Chen et al. (20|3) r III
and their interannual variability ‘enapli AR 2 |
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Objectives of the Post MAHASRI

» General Objective

» Understanding of Asian Land Precipitation over
Diverse Hydroclimatological Conditions: For Better
Prediction, Disaster Reduction and Sustainable
Development.



What is scientific understanding?



Impacts of Scientific Understanding

Rainfall data and satellite validation

» Observation and gauge-based gridded data
» Vietnam/0.ldegs (VnGP)
» Lowlands of Thailand/0.05degs

» Satellite (GPM) validation

» Many validation works

» Uncertainties in orogiraphic precipitation estimations

» Historical data reconstruction (under ACRE)



t Impacts of Scientific Understanding J

Nocturnal LLJ
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Impacts of Scientific Understanding

All models over-estimated precipitable water

_____________________________________________________ 16
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Seasonal cycle between observation and reanalyses,

averaged at 9 GPS stations during 2007~2013

(Wang, Yang et al., 2017, JC)



Impacts rstanding

Positive biases 1n vapor flux results in much more
precipitation in the Plateau and less 1n south slope
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Newly emarging sceince waves



Newly Emarging Science Waves

Impact of historical data rescue

» Kubota et al. (2016)

» PJ (P-] pattern) index from 1897 to 2013 was developed by
use of historical station-based pressure data in Philippine,
Taiwan and Japan, and compared with reanalyses (JRASS,

ERA40, 20CRv2 and NCEP/NCAR.

» PJ-ENSO correlation was found to change in interdecadal time
scale.

NCEP/NCAR (r = 0.59)
20CRV2 (r = 0.54)

& 1900 1910 1920 1930 1940 1950 1960 1970 1980 1990 2000 2010



t Newly Emarging Science Waves J

Boundary Layer -> Tropopause (UTLS)

Ricaud et al. (2014
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Science Strategies

» Impacts of Diversed Land Surface: Topography, Cryosphere,Vegetation,
Land Use and Coast Lines on Diurnally Varying Precipitation Process in
Multiple Time Scales from Sub-seasonal to Climate Change

» Hydrological Modeling which Incorporates Human Water Withdrawal
and Impacts of Agricultural Activity and Biosphere in Monsoon Asia

» Targeted and Integrated Observation Projects Coordinated with New
Generation High Resolution Dataset, Modeling, Radar Network, and
Satellites / Coordinated Regional Process Studies

» Playing a Key Role in S2S (Sub-seasonal to Seasonal) Prediction Project
» Data Rescue for 200-Year Climate Change Detection: with ACRE

» Regional Climate Projection and Dynamic and Statistical Downscaling
Collaborating with Modeling Community including CORDEX



Applications

» Disaster
» Food

» Environment
» Health



Scientific Approaches

» To Understand Asian Monsoon Land Precipitation,

. Observation and Estimation of Variation and Extremes in
Asian Land Precipitation and Important Variables

2. Process Studies of Asian Land Precipitation Focusing on
Diverse Land-Atmosphere Interactions

3. Understanding and Prediction of Variability of Asian Monsoon
from Subseasonal to Interdecadal Time Scales

4. High Resolution Land Surface Hydrological Modeling and
Monitoring Incorporating Impacts of Human Water
Withdrawal, Agriculture,Vegetation and Cryosphere

5. Coordinated Observation and Modeling Initiatives

6. Detection and Projection of the Climate Change Impact on
Regional Precipitation in the Asian Monsoon Region



Science Questions

» What is the convincing climate model representations of Asian
monsoon precipitation that can support policymakers to plan
useful adaptation strategy for the changing climate!?

» What is the possible coordinated observation initiative that
advances our understanding of the Asian monsoon
precipitation?

» To what extent can we use up rescued hydrometeorological
data to reconstruct recent 200-year climate change!?

» How can we find new scientific methods to describe, and to
share information with Asian people, of the extreme weather
embedded in multiple time scales in Asian monsoon
hydroclimate!?

» What is the role of mountain precipitation and subsequent
land water process in the local and global hydrological cycles
and water resources?



Q1: Climate models

» Asian Land Precipitation is controlled by

» multiple scale meteorological disturbances interacting each other
(MISO, BSISO, QBW,WD, TD, SilkRoad, IOD, ENSO, Diurnal, ...)

» land surface impact on the atmosphere through the planetary

boundary layer (Soil Moisture, Land Surface Flux, BL, Convection,
UTLS process, ...)

» We will test huge amount of climate projections (many MIPS,
CORDEX, S2S database, d4pdf, ...) to check if

» they can reproduce multiple scale meteorological disturbances in

their model results
» they can express impact of land surface properly @
» For example:

» http://cola.gmu.edu/dirmeyer/ — )
we will make it appealing single slide



Q2: Observation Initiatives

» Focus:

» Construction of the BRAIN (Borderless
Radar Information Network) within 10-
year project period

» AMY-II (2020)

» Sharing radar data among many Asian
meteorological agencies during core
observation period (May-July / 60days

Feacibility test of
radar network

» Coordinated observations

Pilot areas

Intensive R-S, PBL tower, Soil Moisture,
Wind profiler, GPS-PWV network, ...

» Utilized for model validation

we will make it appealing single slide



Q3: Rescued dataset

» Innovation on methodology to use up rescued data
» knowledge of climate systems and processes
» 20-century reanalysis projects

» activities for further data rescue

» 200yr Climate Reconstruction

e T PJ indbox
-3 JRASS NCEP/NCAR
ERA4D 20CRv2
-4

1900 1910 1920 1930 1940 1950 1960 1970 1980 1990 2000 2010




0Q4: Extremes

» Unprecedently severe hydrometeorological disasters took
place in West-Japan, Kerala, Laos
» Daily rainfall is not enough to describe the extreme
» People's perception on extreme may have to be updated

» We can develop new method to describe, and to share
information with people, the concept of Extreme in multiple
time scales

we will make it appealing single slide



Q5: Mountain precipitation

» Many questions:
» How glacier increases/decreases!?
» What is distribution and variation of montain precipitation?
» Impacts of climate change appears earlier/
» Glacier lakes?
» Scientific interest
» Topographic impact on convective systems

» Impact of Tibetan Plateau on global circulation

» Expected outcomes
» Improved precipitation griddata in Asiatic mountain area

» Reliable estimation of net reduction of glacier
we will make it appealing single slide



South Asian Component of
Asian Mosoon Year (AMY)-II

Section 3




AMY (Asian Monsoon _wensoo,
Years 2007-2012) s

&

.....

Overarching Goal:

“To improve Asian Monsoon
prediction for societal
benefits through improving
understanding of the
variability and predictability
of the Asian-Australian
monsoon system”

' A
4"'2007—20

http://lwww.wcrp-amy.org/
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What can we observe in AMY-II?

» RADAR data exchange for 60day period
» Intensive continuous observation in Bangladesh!?
» Field Campaign

» Soil moisture observation (Remote sensing + ground truth)
Intensified R-S observations

v

» Special instruments
wind profiler, micro rain radar, disdrometers

v

GPS-Precipitable VWater measurement network
Surface Flux observation network
> ...

v

» Modelling and remote sensing
» Possible outcomes by 2023!?



Message

» We are launching new hydroclimatological research
initiative on Asian monsoon under GEWEX/GHP. It will
be approved in GEWEX/SSG in Feb-Mar 2019.

» We tentatively concluded five major Scientific Questions:
Climate Models, Coordinate Observations, Data Rescue,
Extremes, and Mountain Precipitation

» AMY-Il is planned in 2020.WVe will promote people to
conduct AMY-| jointly.

» For South Asian monsoon area, we proposing a
framework based on the concept of interaction of four
major regional hydroclimate systems: Northeast,
Northwest, Central India, and Western Ghats.



HOMNEHTINET !

Arigato- Gozaimasul!

Thank you very much!






1 Precipitation Estimation



2 Process studies



3 Understanding and Prediction S2S<=



S Integrated Observation



6 What is Reliable Climate Projection

» What can we do for that!?



What is RHP (Regional
Hydroclimatological Project)?

Section 1
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[ RHP Status J RHP: Regional Hydroclimatological Project

Active in 4 continents:

Europe: HymEx (2010-2020) ======> High-impact weather events, societal response
Baltic Earth (2016-) ======> Sea and land changes, biogeochemical processes

Australia: OzyWex (2015-) =======> Waler and energy cycle in Australia

Africa: HyVic (2015-2024) ========> Hydroclimatic variability over Lake Victoria basin

North America: CCRN (2014-2018) => Cryospheric, ecological, hydrological interactions
Recently finished:

Asia: MAHASRI (2007-2016) ======> Asian MoNsoon

Eurasia; NEESPI (2004-2015) =====> Northem Eurasian climate-ecosystem-societal interag

e

Ewrope: PannEx (end 20177) =====> Agronomy, air quality, sustainability & water mgnt

In discussion: S—

Exploring possibilties o
in the Americas and Asia, = =

—

Vol Susven N juwn

Carvpny @y

PMeT - vy

G"IP(Courtesy of Prof. Jason Evans, Co-chalr of GHP)




GHP Structure cup. cewex Hydroclimatology Panel

Regional
Hydroclimate C;::z-;:t
Projects J
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Sub-components of GEWEX




WCRP / GEWE

WCRP GEWEX
World Climate Research Global Energy and Water
Programme Exchanges Project




RHP Criteria (Sep. 2013)

» GEWEX Scientific Steering Group (SSG)

» Assesses and approves Project Plans
Next Feb.-Mar.
» RHPs should state

» the central science and applications questions, and

» how to contribute the seven “GEWEX Science Imperatives”,

Data sets, Analysis, Processes, Modeling, Applications, Technology
Transfer, and Capacity Building

» “WCRP Grand Challenges” & “GEWEX Science Questions”
» RHPs should include

RHP’s Science Plan



